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Preface 

 

In the course of the work on the AM 4 Industry project, research on the design and 

simulation of near-contour cooling channels was carried out. One objective was to provide 

toolmaking engineers with an instrument that could be used to further optimise cooling 

channel geometries. Particularly in the design of near-contour and irregular cooling 

channels, simulation using commercial simulation programs may not be sufficient and thus 

require additional simulation steps. For this additional or supplementary simulation step, the 

focus was deliberately placed on a non-commercial simulation program. Therefore, the 

program OpenFoam® (Open Source Field Operation and Manipulation) was chosen for the 

simulations. This is freely available and is mainly used to solve flow problems (Computational 

Fluid Dynamics). It is written in C++ and comes with useful solvers even in the basic version, 

and a wide variety of further solvers can be adapted. One of the major advantages is that the 

source code and thus also the algorithms are freely accessible; and another, that the codes 

and calculations can be extended almost arbitrarily. 

Based on an application-oriented example, this manual describes the structure and the 

performance of a simulation in detail. The solver chtMultiRegion was used for the 

simulations. This is generally used to calculate the heat exchange between a solid and a fluid. 

The objective of this manual is to give users in development, simulation engineers and 

students an application-oriented introduction to OpenFoam®, as well as an overview of 

how to work with it. The individual steps were grouped into nine chapters with the following 

contents: 

 

 Chapters 1 and 2 give a general overview of the simulation example as well as of the 

simulation structures of OpenFoam® 

 

 Chapters 3 to 6 show how a simulation case is set up in OpenFoam®, and which 

settings are required. The creation of the calculation mesh and the allocation of the 

surfaces are dealt with in detail. 

 

 Chapters 7 and 8 address the performance of the simulation. The choice of the 

boundary condition and the theory of flow simulation are dealt with. 

 

 Chapter 9 concludes by discussing the evaluation methods offered by OpenFoam®, 

and how the results can be exported for further processing. 

 

Finally, it should be mentioned that the OpenFoam® environment may seem strange at first 

glance, especially for users accustomed to Windows® operating systems. Patience is 
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definitely required here. It simply takes time for the program’s processes to be perceived 

as logical, and to become proficient in the commands necessary for the operation and 

execution of the program. However, it will certainly be worthwhile to get deeply into this 

topic, as it offers the possibility to further refine one’s simulations and make better 

predictions. This may in turn provide a clear competitive advantage. Thus: Happy Foaming! 
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1. Introduction 
 

The OpenFoam software package usually runs on Linux. In the case described here, on 

Ubuntu version 14.04.5 LTS. For performance of simulations, installation of a Linux operating 

system is necessary. The following options are available for operating OpenFoam or a Linux 

system: 

 

 Direct installation of OpenFoam on a computer with a Linux operating system 

 Dual boot: Two or more operating systems (e.g. Windows and Ubuntu) are installed 

on one computer, and upon each system start you can choose which operating 

system to start with. 

 Use of a server: Installation of a Linux operating system on a separate computer 

which can be accessed via a network with e.g. Putty. 

 

It should also be noted here that OpenFoam does not have a user interface (GUI) by default. 

This means that all commands must be entered via the command line. However, there are 

commercially available GUIs that can make operation easier. These include for example 

CAESES [1], Visual-CFD [2], SimFlow [3], or MantiumFlow [4]. Figure 1 shows the general 

structure of OpenFoam. 

 

Figure 1: Overview of the structure of OpenFoam [5] 

 

This consists of the three sub-areas of pre-processing, solving and post-processing. Pre-

processing does not include the programs such as Blender or PTC Creo, but rather the 

software packages that prepare the geometry for the solvers. These include for example 

blockMesh or snappyHexMesh. The solvers comprise the software packages that perform 

the calculations or simulations, respectively. OpenFoam comes by default with many solvers, 

and more can be added from various internet sources or forums. The solver chtMultiRegion 

is integrated into OpenFoam by default and can be found among the “Heat transfer and 

buoyancy-driven flows” solvers. 

This very chtMultiRegion solver is the focus of this manual. The processes are described step 

by step using an illustrative example. For this purpose, an application from plastics 
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processing or injection moulding technology, respectively, was selected. The simulation is 

intended to help visualise the temperature distribution inside an injection mould. More 

precisely, a so-called variothermal injection moulding process is described. As a matter of 

principle, an injection moulding process is carried out in such a way that plastic granulate, 

which is solid at room temperature, is molten down in a heated cylinder. This is done at 

approx. 200 °C. After plasticising, the plastic material is liquid and is injected into a metal 

mould at approx. 500 bar. 

The metal mould, cooled by means of temperature control units, provides the geometric 

moulding on the one hand and the cooling of the moulded part on the other. However, if 

the moulded part has very subtle structures (microstructures), the conventional mould 

cooling concept is not sufficient. The variothermal process mentioned above is then applied. 

Here, the metal mould is heated approximately to the melting temperature before injection. 

This is then cooled down again already during the injection process.  Figure 2 shows the 

events during the filling process of both process variants. 

 

Figure 2: Filling process during injection moulding, comparison without and with variothermal temperature 

control [6] 

 

Here it can be seen that the plastic melt solidifies upon contact with the cold mould wall. 

This reduces the ability to mould microstructures. However, if the mould wall is heated, the 

plastic melt has sufficient time to creep into the fine structures. The heating and cooling 

process is carried out by two separate cooling units. Water or oil is usually used as the 

cooling or heating medium, respectively. The following figure shows an example of such a 

temperature control concept. 
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Figure 3: Principle of variothermal liquid temperature control with two temperature control units and one valve switching unit 

[6] 

 

In order to be able to manufacture high-quality plastic products, it is essential to know the 

exact mould wall temperature. For this reason, it is worthwhile to simulate this process with 

OpenFoam and take a closer look at it. 

This manual is intended to serve as the first basis for mapping the described processes using 

OpenFoam. For an initial overview, Table 1 shows the individual steps of the approach, 

grouped into preparation, pre-processing, solving and post-processing. With regard to 

modelling and the integration of geometric data into OpenFoam, a wide variety of 

procedures are available. The simulation case described in this paper is solved by the 

following approach: 

Table 1: Procedure for simulation with OpenFoam and chtMultiRegion 

 

Step Description Classification 

1 
Construction of the simulation geometry with PTC 

Creo 

and export of the CAD model as *.stl file 

Preparation (page 7) 

2 Control and post-processing of the CAD model with 

Blender 
Preparation (page 8) 

3 Creation of a first calculation mesh with blockMesh Pre-processing (page 
16) 

4 Refining of the calculation mesh with 
snappyHexMesh 

Pre-processing (page 
21) 

5 Assignment of the regions with splitMeshRegions and 

surfaceToPatch 
Pre-processing (page 

26) 

6 
Simulation of heat flow and exchange, 

respectively, between tool and coolant with 

chtMultiRegion 

Solving (page 32) 

7 Presentation of the results with paraView Post-processing (page 
39) 
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The geometry chosen for the simulation example is an oblong cuboid having a temperature 

control bore in the upper half of its end face. Water at a defined speed and temperature is 

planned to flow through this borehole. The goal is to determine the heating and cooling 

process on the upper surface. The geometry of the simulation is graphically displayed in the 

figure below. 

 

 

 

 

Figure 4: Illustration of the simulation geometry 

 

 

In the following chapters, the simulation example described is documented step by step. 

The commands to be executed are also mentioned in each case. These are displayed in 

colour, with PTC Creo commands shown in blue, Blender commands in yellow and OpenFoam 

commands in red. 
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2. Preparation 
 

Preparation includes all steps that do not need to be performed with OpenFoam or in a Linux 

environment. In this manual or in the example shown, respectively, the design activities were 

carried out using PTC Creo. The construction is not limited to the program Creo, but can be 

chosen arbitrarily. The only precondition is that the 

*.stl format must be used to pass the geometry to OpenFoam. Since errors can often occur 

when exporting the geometry, this is then additionally checked with the freely available 

program Blender [7] and repaired if necessary. A typical error is, for example, a surface that 

is not closed. 

2.1. Construction of the simulation geometry 
 

The first step was to design the basic geometry with PTC Creo. As geometry to be simulated, 

the steel block shown in Figure 4 was chosen, which has a longitudinal bore. This is intended 

to represent a strongly simplified design of an injection mould with a cooling bore running 

through it. The following figure shows the dimensions of this basic geometry. 

 

Figure 5: Basic geometry of the simulation model in the CAD program PTC Creo 

 

The width of the basic geometry is 80 mm, and the height 100 mm. The borehole has a 

diameter of 15 mm and was placed 20 mm beneath the upper surface. This basic geometry 

was extruded to a length of 500 mm. Steel 1.2343 (X38 CrMoV 51) was selected as the 

material, because it is typically used for mould inserts in injection moulds. 

 

Subsequently, this model was exported as an *.stl file. The export function can be found in 

the Creo CAD program under 

File > Save As > Save Copy 
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Then the saving explorer appears. Here select the type “Stereolithography (STL)”. After 

confirmation with “OK”, a window appears in which export settings can be selected. For the 

later processing with OpenFoam, it is necessary that the format is set to “ASCII” (American 

Standard Code for Information Exchange). This determines whether the file should be 

readable only in machine language (binary) or also with a text editor (ASCII). In addition, the 

chord height and the angle control must be adjusted. A value in the range of 0.01 must be 

entered for the chord height, and 1 for the angle control. By specifying the chord height, the 

maximum distance between a chord and a surface is specified. The lower the chord height, 

the smaller the deviation from the actual component surface. For better understanding, an 

explanation is shown in Figure 6. 

Figure 6: Explanation of chord height [8] 

 

It should also be noted that the smaller the chord height is, the larger the exported *.stl file 

will become. The angle control can be adjusted over a range from 0 to 1. This value 

determines the adjustment of the chord height for small radii. The value 1 causes an exact 

adjustment of the triangles to small radii. By contrast, a value of 0 does not result in an 

adjustment. The following Figure 7 shows a comparison of two different settings. 

 

Figure 7: Comparison of two angle control settings [8] 

 

When the format, chord height and angle control have been set, confirm the settings with 

“Ok”, and the geometry will be exported as an *.stl file. 

2.2. Control and post-processing 
 

If the geometry is available as an *.stl file, work can begin in Blender. First the geometry must 

be imported. This can be done with 

File > Import. 

For optimal work with the model, the correct mode must first be set. The initial default setting 

is “Object Mode”. This must be changed to “Edit Mode”. This can be set in the lower screen area 
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(Figure 8). 

 

 
Figure 8: Selecting Edit Mode in Blender 

 

In addition, the selection type must be set to “Face”. This can in turn be selected at the 

bottom of the screen. With 

key “5” 

on the numeric keypad, the zoom behaviour can also be improved. Once these settings have 

been made, a surface can be selected with the right mouse button. To select a plurality of 

surfaces, press and hold the “Shift” key. 

In order for OpenFoam to work with the CAD geometry, open geometric surfaces must first 

be closed. In the case of the geometry shown, for example, the geometry of the cooling 

channel inlet and outlet is not closed. To close these openings, the filling function is a 

suitable choice. To do this, first change the selection mode to point selection (Vertex select). 

Then press 

key “c” 

whereupon a selection circle appears. When the left mouse button is now pressed, all points 

in the selection circle are marked. The selection circle can be reduced or enlarged with the 

mouse wheel. Once all the necessary points have been selected, press the right mouse 

button to end the selection, and then 

key “f” 

to fill the surface enclosed by the points. 

 

Figure 9: Selection circle by pressing the “c” key (left), filling the surface by pressing the “f” key 

 

Between the individual fill commands, it must always be ensured that no other surfaces are 

selected. In order to make sure that no other items are selected, between different 
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commands 

key “a” 

should be actuated to deselect any selected points. After successfully closing all open 

geometries, you can use the function 

Non Manifold 

to check whether all the surfaces are closed. This function can be found at the bottom left of the 

screen at 

Select > Non Manifold or Select > Select All by Trait > Non 

Manifold,  

or by pressing Shift-Ctrl-Alt-M 

If Edit Mode is activated and the view is set to Wireframe, the open areas are highlighted. By pressing 

key “n” 

the XYZ coordinates of the open area can also be displayed. 

 

Figure 10: Menu Item Non Manifold 

 

Once it has been ensured that the geometry is closed, the individual surfaces must be 

defined so that they can later be assigned certain properties in OpenFoam, such as the inlet 

and outlet of the coolant. This means that each surface that is to have its own property must 

be exported separately as an *.stl file. This includes the inlet, the outlet, the cooling tube and 

the steel block. To do this, switch to the surface selection mode and select the surface to be 

defined. Then press 

key “p” 

and select Section. The selected surface then appears separately in the structure tree on the 

right-hand side. Now each surface can be assigned a name. The following definitions are 

important for OpenFoam: 



14/54 

Preparation 

 

 

 

 inlet 

 outlet 

 tube 

 wall 

 

In Chapter 6, the surfaces and regions to be exported are described in detail. If individual 

partial surfaces are overlooked during selection of the surfaces, they can be added 

afterwards. Select the overlooked surfaces and press key “p”. Then select the overlooked 

surfaces and the area where they are to be added, and click on 

Tools > Edit > join 

to execute the join command. This merges the two selected surfaces. In order for the 

model to be properly simulated, the following *.stl files must be available for import into 

OpenFoam: 

 

 inlet (single) 

 outlet (single) 

 tube (single) 

 wall 

◦ (all that do not belong to inlet, outlet or wall) 

 solid 

◦ (wall – all the surfaces that should later have the same solid boundary condition) 

 fluid 

◦ (inlet, outlet and wall – all the surfaces that should later have the fluid boundary condition) 

In order to export a plurality of surfaces as a single *.stl file (e.g. fluid), they must be selected 

on the right-hand side in the structure tree. Selection of a plurality of files is done with 

Shift + left mouse button 

After selection of the individual surfaces, they can be 

exported under File > Export > STL (*.stl). 

When exporting, make sure that in the export menu the check mark is set at 

“ASCII”. 



15/54 

Preparation 

 

 

 

 
Figure 11: Blender menu item of the *.stl export 

 

Figure 12: Blender *.stl export settings, ASCII 

STL 

ASCII 
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3. Pre-processing with OpenFoam® 
 

In order to be able to start pre-processing in OpenFoam, all the geometries must be 

separately available, i.e. inlet.stl, outlet.stl, tube.stl, wall.stl, fluid.stl and solid.stl must be on 

hand. 

Once all geometry files are available, construction of the simulation can be started. The case 

described in this simulation example is intended to show the heating and cooling process of 

a steel block through which a medium flows. To this end, the geometry is first meshed using 

blockMesh and snappyHexMesh. The temperature distribution is then to be displayed using 

the solver “chtMultiRegionFoam”. 

 

Simulations performed with OpenFoam often have the following standard structure: 

 

Figure 13: Folder structure of most OpenFoam simulations 

 

When starting to set up a simulation in OpenFoam, it is advisable to copy an existing 

simulation case and adapt it. For most solvers, there are examples in the standard installation 

of OpenFoam to be found in the folder “tutorials”. 

The simulation example, which is described in more detail in the following steps, is 

structured as follows: 

 

Name of the simulation example: cfdkurs 

Storage location of the simulation example: ~/OpenFOAM/OpenFOAM-

3.0.1/simulations/CFD-Kurs/cfdkurs$ 
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In the storage location of the simulation example, also known as the home directory, in the 

following all commands are executed in the terminal (shell). This means, for example, if the 

first calculation mesh has to be created with blockMesh, the cfdkurs folder has to be opened 

first, and then the command >blockMesh entered. The cfdkurs directory contains the folders 

0, constant and system. 

3.1 Mesh creation – General 
 

In OpenFoam, the mesh can be created using the SnappyHexMesh function. The process of 

such a creation will be explained by means of a simple example [9], [10]. 

 

Step 1: For the first step, an *.stl file of the geometry is needed. In this file, created 

suing the CAD program, the surface of the geometry is described by means of 

triangles. 

Step 2: A first background mesh is superimposed on this geometry using blockMesh. 

The blockMesh function can be used to create a cuboid, which is split into 

several cubic or cuboidal cells. In blockMeshDict, the text file used to execute 

blockMesh, the coordinates of the corner points of the cuboid and the number 

of cells in between are defined. 

Step 3: The snappyHexMesh function now refines the cells surrounding the STL surface. 

How often these cells are to be refined is defined in snappyHexMeshDict. 

Step 4: The cells either inside or outside the viewing space are then removed, and the 

remaining ones further refined. 

Step 5: In a final step, the edges and surfaces are smoothed. In addition, additional 

layers can be introduced to refine the transition between the cells and the 

geometry surface and thus increase the resolution. 

 

Steps 3 through 5 are all performed in one operation during the execution of 

snappyHexMesh and are precisely defined in the system folder in snappyHexMeshDict. 

 

Figure 14: Step 1, existing *.stl file 
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Figure 15: Step 2, creation of a blockMesh block (background mesh) 
 

Figure 16: Step 3, refining of the mesh using the SnappyHexMesh function 
 

Figure 17: Step 4, removal of cells inside or outside the viewing space 
 

Figure 18: Step 5, smoothing and refining of the mesh 

 

The following sections provide a more detailed description of the procedure described 

here. 
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4. First calculation mesh – blockMesh 
 

Before the creation of a first calculation mesh is started, it must be ensured that the 

geometry has the correct scaling. When creating the *.stl file or when exporting, respectively, 

pay attention to the units with which the geometry is exported. OpenFoam works with SI 

units, therefore all geometric dimensions are in metres. If, for example, the geometry has 

been exported in millimetres, a transformation can be performed within OpenFoam. This 

can be done using the command >transformPoints. 

 

>transformPoints -scale '(0.001 0.001 0.001)' -region fluid 

>transformPoints -scale '(0.001 0.001 0.001)' -region solid 

 

Using blockMesh, a background mesh is superimposed on the geometry as described 

above. To execute the command blockMesh, the corresponding text file blockMeshDict and 

the text file controlDict are needed. Both are saved in the “system” folder and are usually 

copied from other simulation templates and then adapted to the respective new case. With 

the following command, a text file can be copied into a new folder: 

 

>cp Path-where-the-file-is-located Destination-folder/ 

 

Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs$ cp 

StandardVersuchBaseCaseVH/system/blockMeshDict system/ 

 

In the text file blockMeshDict, the coordinates of the corner points of the cuboid and the 

number of cells in between are defined. The following Figure 19 shows the blockMeshDict 

file. 
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Figure 19: Text file blockMeshDict (left), description of the coordinate points (right) [11] 

 

From line 19 to line 28, the vertices of the rectangle are given in X, Y, Z format. Line 33 

contains the following information: 

 

 hex (0 1 2 3 4 5 6 7) Definition of the hexahedral block. Pay attention to the order! 

 (30 10 10) Number of cells between corner points 

 simpleGrading (1 1 1) Scaling of the cells between the corner points 

There are two ways to superimpose a suitable block on the geometry. Either the corner 

coordinates are known and entered in the blockMeshdict file, or the coordinates are 

unknown and must be determined. If unknown, they can be determined using Paraview. In 

doing so, the STL part geometry and the generated blockMesh block are visualised in 

Paraview, and the respective values are read. In order to display the blockMesh block, the 

following points must be fulfilled: 

 

 blockMeshDict text file exists in the system folder 

 controlDict text file exists in the system folder 

 blockMesh executed in terminal 

◦ >blockMesh 

 Dummy file foam.foam present in the case folder 
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To create a dummy file in the case folder, the following command must be executed: 

>nano foam.foam 

 

Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ nano foam.foam 

 

The text editor opens, and an empty text file appears.  

Ctrl + O 

saves the file, and  

Ctrl + X 

closes the editor again. Paraview can then be opened via the following command: 

>paraview 

The *.stl geometry data and the dummy file foam.foam must then be opened in Paraview:  

File > Open > foam.foam 

If the file is not displayed immediately, the opening must be confirmed with “Apply”. 
 

Figure 20: Created block in Paraview 

 

The corner point coordinates of the selected geometry are displayed in the Information 

section in the lower left menu area. Figure 21 shows the corner point coordinates of the 

solid.stl geometry. 



22/54 

First calculation mesh – 

blockMesh 

 

 

 

 
Figure 21: Corner point coordinates of the solid.stl geometry 

 

Now the coordinates of the simulation geometry, which are read from Paraview, must be 

entered into the text file blockMeshDict. Here the blockMesh block should always be 

selected to be slightly larger than the simulation geometry. In the example shown, the 

blockMesh block is 5 units larger than the simulation geometry is. The block generated thus 

has the following dimensions: 

 

Figure 22: Corner point coordinates of the generated BlockMesh block, entered in the blockMeshDict file 

 

After the corner point coordinates have been entered into the blockMeshDict-File, the 

display in Paraview still has to be updated with “refresh”. The previously defined block will 

then appear in the viewing area (Figure 23). 
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Figure 23: Simulation geometry with the BlockMesh block (mesh) superimposed 

 

The shape of the rectangles should ideally be cubic. This can be adjusted by adjusting the 

splitting in the blockMeshDict text file. To this end, the text file blockMeshDict has to be 

opened, and the line 33 “(30 10 10) – Number of cells between the corner points” 

modified. By executing the blockMesh command again, the adjusted data are accepted: 

>blockMes

h Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ blockMesh 
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5. Second calculation mesh – snappyHexMesh 
 

The snappyHexMesh program then refines the cells surrounding the STL geometry. In order 

to perform the refinement with snappyHexMesh, the following files must first be copied into 

the “system” folder: 

 

 system 

◦ snappyHexMeshDict 

◦ meshQualityDict 

◦ surfaceFeatureExtractDict 

◦ fvSchemes 

◦ fvSolution 

Furthermore, the *.stl files must be located in the folder “constant”: 

 

 constant 

◦ Folder “triSurface” (may have to be created) 

▪ solid.stl 

▪ fluid.stl 

If the folder “triSurface” does not exist, it can be created without further ado. This can be created 

with the following command: 

>mkdir triSurface 

Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs/constant$ mkdir triSurface 

 

Next, you can start to adapt the text files. The content of the text file 

„snappyHexMeshDict“ is shown in the following figures: 
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Figure 24: Content snappyHexMeshDict file, line 1-232 
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Figure 25: Content snappyHexMeshDict file, line 233-336 

 

Here, the geometry files must first be adapted. Here, under geometry (line 

30) the STL geometries used must be specified. In the example, this comprises the following 

*.stl files: 

 

 solid.stl 

 fluid.stl 

The remaining entries under geometry can be deleted. In addition, the entries for 

“features” (line 103) can be changed in analogy to the geometry change. 

 

 

The section “refinementSurfaces” (line 138) must also be adapted. The names must again 

be changed to “solid” and “fluid”. In the entries “faceZone” and “cellZone”, the 

names of the *.stl files have to be entered. In addition, coordinates of a point located inside 

the geometry to be meshed must be specified. This must be entered for “solid” and 
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“fluid”. Line 201 comprises the entry “locationInMesh”, where again a point inside the 

geometry to be meshed has to be specified.  Specification of a point inside a geometry 

serves to define the start of meshing, or whether the inner or outer geometry is to be 

meshed, respectively. 

Figure 26 below shows the contents of the meshQualityDict file. This is also required for the 

simulation, but no changes are necessary. 

 

Figure 26: Content of the meshQualityDict file 

 

In the text file “surfaceFeatureExtractDict” (Figure 27) again the names of the *.stl files 

have to be entered (lines 17 and 33). 

 

Figure 27: Contents surfaceFeatureExtractDict file 

 

After all text files have been adjusted, the command 
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>surfaceFeatureExtrac

t  

has to be executed. 

Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ 

surfaceFeatureExtract  

This will generate the files 

 solid.eMesh 

 fluid.eMesh 

in the folder “triSurface”. Then the command 

>snappyHexMesh -overwrite  

can be executed.  

Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ snappyHexMesh -overwrite 

 

The command “-overwrite” is used, since otherwise a new folder will be created if a 

mesh already exists. 
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6. Creation and allocation of the regions 
 

Since in this example the heat transfer from a liquid to a solid substance is simulated, the 

individual geometries must be classified. This serves to inform the program as to which 

geometry or volume is a solid or a liquid, and to be able to assign adapted material 

parameters to it afterwards. 

 

 

 

 

 

 

 

With Blender, in a previous step the geometries were exported individually as *.stl files. Here, 

the geometry solid.stl consists of wall.stl and tube.stl. The fluid.stl geometry consists of 

tube.stl, inlet.stl and outlet.stl. This means that a total of 7 individual *.stl files must exist. 

Depending on the simulation set-up, the geometry “tube.stl” may not be required. Figure 

28 illustrates the individual STL geometries. 

 

Figure 28: Illustration of the individual *.stl files 

 

The individual *.stl files must be assigned to certain regions. A list of the *.stl files with the 
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corresponding regions is shown in Table 2. 

Table 2: Splitting of the *.stl files into regions 

 

*.stl file Region 

tube.stl fluid 

inlet.stl fluid 

outlet.stl fluid 

wall.stl solid 

 

Before these are assigned, the zones (Fluid and Solid) must first be split. This is done with 

the following command: 

>splitMeshRegions -cellZones -overwrite  

Example: 

~/OpenFoam/OpenFoam-3.0.1/simulations/CFD-Kurs/cfdkurs$

 splitMeshRegions -cellZones

 - overwrite 

 

The individual *.stl files or surfaces, respectively, must then be assigned to the regions. This 

is done with the command: 

>surfaceToPatch „Location of the *.stl file“ -region „fluid or 

solid“ Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ surfaceToPatch 

constant/triSurface/inlet.stl -region fluid 

 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ surfaceToPatch 

constant/triSurface/outlet.stl -region fluid 

 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ surfaceToPatch 

constant/triSurface/tube.stl -region fluid 

 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ surfaceToPatch 

constant/triSurface/wall.stl -region solid 

 

Here, the following error message may appear (Figure 29): 

-->FOAM FATAL ERROR: 

Wrong number of arguments, expected 1 

found 2 Invalid options: -region 
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Figure 29: Error message when entering the command “surfaceToPatch constant/triSurface/inlet.stl -region fluid” 

 

In this case, an additional step must be performed, or the regions must be assigned 

separately. I.e., the surfaceToPatch command must be executed in a separately created 

folder. This allows assigning (patching) the regions separately from each other. For this 

reason, dummy folder structures are created (fluid > constant > polyMesh), since otherwise 

OpenFoam would not recognise the folder structure. If only one region existed, i.e. solid or 

fluid alone, the surfaceToPatch command could be executed directly in the main folder (in 

the example “cfdkurs”). 

However, since there are two regions in the example, the following step must be performed: 

 

1. First you have to create the folders “solid” and “fluid” in the main folder. 

2. A constant folder must then be created in each of these folders. A folder is created 

with the command >mkdir folder name. 

3. The polyMesh folder of the main folder (~/OpenFOAM/OpenFOAM-

3.0.1/simulations/CFD-Kurs/cfdkurs/constant) must then be copied 

into this constant folder. 

4. Furthermore, the folder system must be created in the respective folder (solid and 

fluid), and the file controlDict must be copied into this folder. This can be found in 

the main folder (cfdkurs) in the system folder. 

5. Finally the corresponding *.stl files have to be copied into the created folders fluid 

and solid. 

 

After creating and copying the files, the folder structure must look as follows: 

 

cfdkurs 

 constant 

o polyMesh 

o fluid 

 polyMesh 

o solid 

 polyMesh 
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 solid 

o constant 

 polyMesh 

o system 

 controlDict 

o wall.stl 

 fluid 

o constant 

 polyMesh 

o system 

 controlDict 

o inlet.stl 

o outlet.stl 

The directory constant > solid may only contain the *.stl files of the outer walls. This means, 

for example, that the wall of an inner pipe must not be included. After the folder structure 

has been created, navigate to the created folder (solid or fluid) and execute the 

surfaceToPatch command for each contained *.stl file: 

>surfaceToPatch CAD_file.stl 

Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs/solid$ surfaceToPatch wall.stl 

 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs/fluid$ surfaceToPatch inlet.stl 

etc. 

Between running this command for each individual *.stl file, the patch0 entry in the 

polyMesh-boundary file must be changed. The individual procedures are described step by 

step below: 

Example for Fluid 

 

cfdkurs > fluid > 0.1 

 Open first time step folder (0.1) (not 0) 

 Open polyMesh folder 

 Open boundary file 

 Rename patch0 to inlet 

(or to the name used in sufaceToPatch, respectively) 

 Run > surfaceToPatch outlet.stl in the cfdkurs folder > fluid 

 Open cfdkurs > fluid > 0.2 

 Copy polyMesh folder and paste it into 

cfdkurs > constant > fluid 

 Then the entire cfdkurs > fluid folder can be saved as a backup or deleted 
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After that, the following entries in the boundary file have to be deleted, and the number in 

row 18 (Figure 30) has to be changed from 4 to 3, because the number of patches has 

changed. If this is not changed, an error message will appear when the results are later 

displayed in Paraview. The following command (e.g. for the region solid) can be used to 

check the correctness of the generated mesh: 

 

> checkMesh -region solid 

 

Example: 

~/OpenFOAM/OpenFOAM-3.0.1/simulations/CFD-Kurs/cfdkurs$ checkMesh -region solid 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 30: boundary file of the fluid 

 

In order to be able to assign their properties and initial conditions to the regions, a 

regionProperties file is required in constant. The following entries must exist in it: 
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Figure 31: regionProperties file in folder constant 

 

 

Once these steps have been carried out, the initial and boundary conditions can be 

entered. 

 

7. Solving – Simulation with chtMultiRegion 
 

In the selected simulation case, the heating and cooling process is considered. During the 

heating process, water at a temperature of 90 C flows through the pipe for 10 seconds. This 

is followed by the cooling process, during which water at a temperature of 30 °C flows 

through the pipe for 10 seconds. In addition, the simulations are carried out with two 

different Reynolds numbers or flow velocities, respectively, in order to be able to observe 

the heat transfer in a laminar and turbulent flow. 

7.1. Theory of flow simulation 
 

The turbulence model standard k-epsilon was used for the simulation of the flow in the 

channel. This is a two-equation model and is the most commonly used model to describe 

flows in CFD simulations. In the transport equation, the production and diffusion for 

turbulent kinetic energy k are approximated. 

 

 𝑃𝑘 = −(2𝜈𝑇 𝑆𝑖̅𝑗) 𝑆𝑖̅𝑗 = −2𝜈𝑇 (𝑆𝑖̅𝑗)
2
 (1) 

   

 𝐷𝑘 =
𝜕

𝜕𝑥𝑗
(𝜈

𝜕𝑘

𝜕𝑥𝑗
+

𝜈𝑇

𝜎𝑘

𝜕𝑘

𝜕𝑥𝑗
) = [(𝜈 +

𝜈𝑇

𝜎𝑘
)

𝜕𝑘

𝜕𝑥𝑗
] (2) 

 

 

Based on several assumptions (e.g. pressure-velocity correlation) and approximations (e.g. 

Boussinesq approach), the equations of the standard kε model are finally as follows [12]: 
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𝜕

𝜕𝑥𝑗
(𝑢̅𝑗𝑘) = −𝜈𝑇(𝑆𝑖̅𝑗)

2
− 𝜀 + [(𝜈 +

𝜈𝑇

𝜎𝑘
)

𝜕𝑘

𝜕𝑥𝑗
] (3) 

   

 𝜕

𝜕𝑥𝑗
(𝑢̅𝑗𝜀) = {𝑐𝜀1

𝜀

𝑘
} [−𝜈𝑇(𝑆𝑖̅𝑗)

2
] − {𝑐𝜀2

𝜀

𝑘
} 𝜀 + [(𝜈 +

𝜈𝑇

𝜎𝜀
)

𝜕𝜀

𝜕𝑥𝑗
] (4) 

 

𝑃𝑘 Production 
𝐷𝑘 Diffusion 
𝜈𝑇 Vortex viscosity 

𝑆𝑖̅ 𝑗 viscous stress tensor 

𝑥𝑗 Place coordinate 

̅ 𝑢̅𝑗 average speed 

𝑘 turbulent kinetic energy 
𝜀 isotropic dissipation rate 
𝐶µ model constant 
𝑐𝜀1 model constant 
𝑐𝜀2 model constant 
𝜎𝑘 model constant 

𝜎𝜀 model constant 

 

Typically, the model constants are defined as follows: Cµ = 0.09; cε1 = 1.44; cε2 = 1.92; σk = 

1.0; and σε = 1.3. 

 

To be able to calculate yPlus, turbulent initial values are required, which are calculated s 

follows [13]: 

 

𝑘 =
3

2
(𝐼 ∗ |𝑢𝑟𝑒𝑓|)2 

assumed to be 0.8. uref is the velocity, 

 

𝜀 =
𝐶𝜇

0,75 ∗ 𝑘1,5

𝐿
 

 

ε is the turbulent dissipation rate, Cµ a constant with the value 0.09, and L the length of the channel. 

 

𝑣𝑡 = 𝐶𝜇

𝑘2

𝜀
 

νt is the turbulent viscosity. 

The following values result from the illustrated formulas for the simulation example: 

 

k =0.273 

ε =1.563 

ν = 0.00324 
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7.2. Input parameters 
 

To complete the simulation, the input parameters for laminar and turbulent simulation are 

listed below. For the inlet speed (initial condition), the following formula was used in both 

cases: 

 

 𝑅𝑒 =
𝑢 𝐷

𝜈
 (5) 

 

Here, Re is the Reynolds number in [1], u the velocity in [m/s], D the diameter of the channel 

in [m], and ν (nu) the kinematic viscosity in [m²/s]. The kinematic viscosity of water at different 

temperatures was taken from the following table: 



37/54 

Solving – Simulation with chtMultiRegion 

 

 

 

Table 3: Substance parameters of water at different temperatures [14] 

 

 

The pressure of the water flowing through is 5 bar (5∙105 Pa). At the beginning of the 

simulation, the metal block through which the coolant flows has a constant temperature of 

30 °C. 

 
7.2.1. Input parameters Laminar 

 

Reynolds number 
Channel diameter 

Re = 
D = 

500 
0.015 m 

Kinematic viscosity, water ν = 0.801 * 10-6 m²/s at 

30 °C 
0.326 * 10-6 m²/s at 
90 °C 

This results in the following velocities: 

 Flow velocity u = 0.0267 m/s at 30 °C 

0.011 m/s at 90 °C 

 
7.2.2. Input parameters Turbulent 

 

Reynolds number 
Channel diameter 

Re = 
D = 

10.000 
0.015 m 

Kinematic viscosity, water ν = 0.801 * 10-6 m²/s at 30 °C 
0.326 * 10-6 m²/s at 90 °C 

This results in the following velocities:  

Flow velocity u = 0.533 m/s at 30 °C 

0.217 m/s at 90 °C 

 

These input parameters or initial conditions are defined in documents located in the folder 
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0>fluid. This contains the files alphat, epsilon, k, nut, p, p_rgh, T and U. The files p and T are 

present in the folder 0>solid. 
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To be able to use the k-ε model, the yPlus value, which provides a statement about the cell 

height nearest to the wall, must have a value between 20 and 100. The value is checked with 

the following command: 

 

> yPlus -region fluid 

 

In order for this command to be executed, the following folder structure and the listed 

files must be included: 

 

0 

 fluid 

o alphat 

o epsilon 

o k 

o nut 

o p 

o p_rgh 

𝑘𝑔 

𝑚 𝑠² 
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o T 

o U 

 solid 

o p 

o T 

 

The screenshots of the text files can be found in the Annex in sections 10.1. to 10.2. 

In the fluid files, the names of the geometries must be adapted for epsilon, k, nut, p, p_rgh, 

T, U in the entry boundaryFields. In the simulation example, inlet, outlet and fluid_to_solid 

thus need to be entered. For the solid files p and T, wall and solid_to_fluid must be entered. 

In addition, the initial conditions must be adapted, including speed [m/s], pressure [Pa], and 

temperature [K]. 

 

The folder constant must contain the following folders and files: 

 

constant 
 fluid 

◦ polyMesh (folder) 

◦ fvSchemes 

◦ fvSolution 

◦ g 

◦ thermophysicalProperties 

◦ transportProperties 

◦ turbulenceProperties 
 solid 

◦ polyMesh (folder) 

◦ fvSchemes 

◦ fvSolution 

◦ thermophysicalProperties 

The screenshots of the text files can be found in the Annex in sections 10.3. to 10.4. 

 

Once all adjustments have been made, the yPlus command can finally be executed for 

solid and fluid: 

 

>yPlus -region fluid 

>yPlus -region solid 

 

Since the yPlus value in the example shown was over 100, the cells at the fluid-solid 

boundary were refined with the following command: 

 

>refineWallLayer '(fluid_to_solid)' 0.5 

 

(no -region option and must therefore be executed in the folder where inlet and outlet 



41/54 

Solving – Simulation with chtMultiRegion 

 

 

were patched) 

 

After refining, the generated polyMesh folder must be copied to constant > fluid. 

The refineWallLayer command inserted additional cell rows, reducing yPlus to an average 

value of 54.74426. Figure 32 shows the refined mesh: 

 

 

Figure 32: Refined meshing at the cooling tube geometry 

 

 

A value of 30 °C is defined as the initial temperature for the solid. In addition, the boundary 

condition on the outer wall should be defined by changing the entry 

„externalHeatFluxTemperature“. It is specified that a constant heat transfer coefficient of 

10 W/m²K is used for the heat transfer between the solid and the environment. This means 

that the environment or air, respectively, is not mapped in the simulation, but only taken into 

account with the constant boundary condition mentioned. 
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8. Running the simulation 
 

In order to be able to start the simulation, the general conditions must be defined. These 

can be found in the constant folder. The following entries should be defined: 

 

 Material data for fluid and solid are specified in thermophysicalProperties; these files 

are located in the constant folder. This includes values such as thermal conductivity 

or capacity, which are commonly used for steel and water. 

 

 For the turbulent simulation, a file called turbulenceProperties is required in which 

the turbulence model to be used is defined. 

 

 The numerical settings found in fvSchemes and fvSolution were used by default. 

 

 In controlDict it was specified that the first part of the simulation (=heating process) 

takes 10 seconds and is stored every 0.1s. 

 

 In order to be able to simulate a heating and cooling process taking a total of 20 

seconds, the inlet temperature and velocity in the files T and U in folder 10 (simulation 

time switch folder) were adjusted after a 10-second heating phase in order to be able 

to finally also display the cooling phase. 

 

The screenshots of the text files can be found in Annex 10. Finally, with 

 

>chtMultiRegionFoam 

 

the simulation is started. After the turbulent simulation has been completed, the laminar 

simulation can also be created. For this purpose, a copy of the entire turbulent case (cfdkurs) 

is created (cfdkurslaminar). In order to perform a laminar simulation with this copied case, 

the following changes must be made: 

 

 The speed in the folder 0 > U is reduced to map a laminar flow. 

 In the turbulenceProperties file in the constant folder, the flow type is changed to laminar. 
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9. Results 

9.1. Heating and cooling process 
 

After the simulation, the heating and cooling process was imaged in Paraview. The following 

figures show the results graphically in steps of 2.5 seconds. The turbulent simulation case is 

shown on the left and the laminar simulation case on the right. 

 

 

Turbulent (left) 

Laminar (right) 

 

Initial state 

Constant 30 °C 

t = 0 seconds 

 

 

 

Turbulent (left) 

Laminar (right) 

 

Heating 

process 

t = 2.5 seconds 

 

 

 

 

Turbulent (left) 

Laminar (right) 

 

Heating 

process  

t = 5 seconds 
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Turbulent (left) 

Laminar (right) 

 

Heating 

process  

t = 7.5 seconds 

 

 

 

 

Turbulent (left) 

Laminar (right) 

 

End of heating-up 

process and start of 

cooling-down process 

t = 10 seconds 

 

 

Turbulent (left) 

Laminar (right) 

 

Cooling 

process  

t = 12.5 

seconds 

 

 

Turbulent (left) 

Laminar (right) 

 

Cooling 

process t = 15 

seconds 
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Turbulent (left) 

Laminar (right) 

 

Cooling 

process  

t = 17.5 

seconds 

 

 

Turbulent (left) 

Laminar (right) 

 

End of cooling 

down  

t = 20 seconds 

 

 

 

 

 

From these figures it can be seen that the turbulent variant reacts much more dynamically 

to the temperature change. To illustrate this fact, diagrams of measuring points can be 

created on the surface. The export of simulation data is described in more detail in 

subsection 9.2 below. Two points on the surface were defined for the export (Figure 34). 

 

Figure 33: Defined measuring points on the surface of the simulated geometry 
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The first measuring point is 10 mm behind the inlet. The second measuring point was placed 

exactly in the middle of the block and is thus 250 mm from the inlet. For these points, the 

measured values are then generated and displayed in diagrams (Figure 34 and Figure 35). 

Figure 34 shows the temperature profile at a position 10 mm behind the inlet for the 

turbulent and laminar cases. In the turbulent case, the flow velocities are 0.533 m/s at 30 °C 

and 0.217 m/s at 90 °C. In the laminar case, the flow velocity is 0.0267 m/s at 30 °C and 0.011 

m/s at 90 °C. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 34: Temperature profile on the surface, inlet, position 0.01 m 

 

It can be seen that the turbulent case behaves much more dynamically than the laminar one 

does. This is due to the increase in the heat transfer coefficient between solids and fluid at 

high Reynolds numbers. Figure 35 shows the temperature profile at the 250-mm position 

downstream of the inlet. 
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Figure 35: Temperature profile on the surface, block centre, position 0.25 m 

It can be seen that the temperature increase is about 10 °C lower compared to the 

measuring point at 10 mm. In the laminar simulation case, there is no temperature increase, 

since the flow velocity is so low that the warm water arrives at the measuring point at 250 

mm only in the middle of the cooling process. 

9.2. Export of the measured values 

After the geometry is displayed in Paraview, using the function ProbeLocation (Figure 

36) a measuring point can be generated on the surface of the simulated geometry. 

 

Figure 36: Paraview function ProbeLocation 

 

Using the command at File > Save Data, selected data for the time steps can then be output. 

In the example shown, the temperature data are output. The drawback of exporting data in 

this way is that an Excel file is created for each time step. However, in the folder where the 

files are stored, the command 

 

for i in `seq 0 1 200`; do cat T.$i.csv >> masterT01.csv; done 

 

can be used to merge them into a single Excel file. However, this command also merges the 

headings of the 200 files, so that each measured value line has a superfluous heading line. 
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To delete these, the following commands must be executed: 

 

 Open the file 

>vim createdfile.csv 

 Start macro recording: Press 

key “q” twice to start 

macro recording 

 Delete row 

Press key “d” twice 

Arrow down to skip line 

 End macro recording: Press 

key “q” once 

 Execute command several times a certain 

number: Enter the number of executions on the 

numeric keypad Start execution with @q 

 Save and Exit 

:wq (write and quit) 

 

It should be noted that Paraview has extensive options for the evaluation of various 

simulation cases. The examples shown here represent only very small portions of the 

available possibilities. Further information on the evaluation methods and tutorials for using 

Paraview can be found directly on the Paraview website [15]. 
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10. Annex 

10.1. Folder 0 > fluid 
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10.2. Folder 0 > solid 
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10.3. Folder constant > fluid 
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10.4. Folder constant > solid 
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